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Description 

We will demonstrate a number of features of the OMERO platform using an OMERO server based in 
Dundee, U.K. You can connect to the same server using login details provided to try the software for 
yourselves. 

Browse Images 

For this workshop, images have already been imported into OMERO. The import instructions can be 
found at ​http://help.openmicroscopy.org/importing-data-5.html 

1. Log in to the webclient with the Username and Password provided.  
2. You can browse the hierarchy of ​Projects (blue) > Datasets (green) > Images​ in the 

left-hand pane. Selecting a ​Dataset ​will show Images in the centre pane. 
3. OMERO can handle images of many different file formats and sizes using Bio-Formats. In 

the ​Dataset SVS ​there are Images of size 96999 x 45667 pixels. We will use smaller 
timelapse Images for this workflow. 

4. Open the ​Dataset​ ​condensation​. 
5. Select Images to view details in the right-hand pane. Image metadata such as width, 

height, number of Z sections or Timepoints, Channels and Pixel size is shown here.

 

 

 

https://downloads.openmicroscopy.org/presentations/2018/ELMI-Dublin/OMERO-Workshop/index.html
https://downloads.openmicroscopy.org/presentations/2018/ELMI-Dublin/OMERO-Workshop/index.html
http://help.openmicroscopy.org/importing-data-5.html


   
 

Add Annotations, Filtering and Searching 

1. Let’s now add annotations to Images in the ​General​ tab of the right-hand pane. 
2. Select one or more Images from the Dataset​ ​condensation​ ​and click the harmonica 

Key-Value Pairs ​in the right-hand pane. 

 
3. You should see a table or tables, depending on the number of selected Images:

 
4. The ​Key-Value Pairs ​allow you to add lab-book like additional metadata for the Image. 

These ​Key-Value​ ​Pairs ​are also specifically searchable. 
5. It is also possible to add Tag, Attachment, Rating etc. 
6. Enter ​mitomycin-A​ ​into the search box in the top right of the weblicent 

  and press Enter. 
7. The search results will show any objects e.g. Images or Datasets which have anywhere the 

string ​mitomycin-A​.​ Several images should be found. 
8.  Refine the search now for only ​Key-Value Pairs​ which have the key ​mitomycin-A​ and 

value ​0mM​ by entering ​mitomycin-A:0mM​ ​into the search box and pressing Enter. Now 

you should find only 10 images. Click on the ​Browse​ link in one search result line, 
(in the right-hand part of the centre pane) to navigate back to the main webclient. 

9. Images can also be filtered by Tag or Rating in the centre pane, using the ​Add filter 
chooser above the thumbnails,.  

10. Choose the ​Tag ​option and then choose the ​Mitosis​ from the list of Tags. As mentioned 
already, the ​Mitosis​ ​tag was added to 6 Images before this workshop. 

11. Review the filtered Images, choose a favourite Image and under the ​Rating​ section in the 
right-hand pane, click on the 5th star to add a rating of 5 

12.  
13. Repeat this to add a rating of 5 to the ​Apoptosis​-tagged Image. 



   
 

14. Now we can remove the filtering by Tag and instead filter by ​Rating of 5​ to show only our 
favourite images.  

 

View Images 

1. Double-click on an Image thumbnail, or click the ​Full Viewer​ button in the 
right-hand pane to open an Image in a larger viewer called OMERO.iviewer. 

2.  
3. We can adjust the rendering settings and scroll through T and Z if it is a Z-stack image. 

4. Click the ​Crosshairs​ icon  at the top right of the viewer to enable pixel intensity display 
for the mouse pointer. Then mouse over the Image to see the pixel intensities for the 
enabled channels. 



   
 

5.  

6. The ROIs tab includes tools for viewing and drawing ROIs on the Image. 
These are saved back to the OMERO server. Select the ​arrow tool​ in the right-hand pane 

 and draw an arrow on the Image, using Click-Release-Drag, pointing to a feature in 
the Image, which will be later used by OMERO.figure and save it using the ​Save button

 located in the upper part of the right-hand pane. Draw also a couple of other ROIs 
on different T planes. 

7. Clicking onto the ROIs in the right-hand pane table brings the viewport to the position 
where the selected ROI is in the middle of it and navigates the viewport to the timepoint the 
ROI is associated with.  

8.  
9. Save the viewport by selecting in the top-left corner ​File > Save Viewport as PNG 
10. Compare the two channels of one of the Images in multi-image view. Double-click on the 

thumbnail of the already opened Image in the left-hand pane of the viewer. This will open 
the Image again in a new window. Select one of the windows and in the right-hand pane 
switch the green channel off.  



   
 

11.  
12. We can synchronize the viewers by adding them both to the same sync Group. Click the 

sync icon  in the top-left corner and select the first option in the dropdown menu. 
Repeat for the other viewer. Now both Images have the ​Z/T​ and ​View​ (zoom and position of 

viewport) synchronized . 
13. Select the Red channel Image (DNA staining) and play the timelapse by clicking onto the 

arrow​ at the bottom of the image window. After you have identified a mitotic cell, zoom in 
onto it by scrolling the mouse wheel or expand the ​cog ​icon in the top bar of the window 
and click on ​plus​ sign. Pan the viewport so that the mitotic cell is in the centre. The Green 
channel (nuclear envelope staining) window will mimic all the actions as well. 

14.  



   
 

 

Analyze with ImageJ/Fiji: Manual workflow (NOT PRESENTED, for information only) 

1. We will ​not​ demonstrate this manual workflow, this chapter is for information only. 
2. In this manual workflow section, we use ImageJ/Fiji and use the OMERO ImageJ plugin to 

analyze Images stored in OMERO. Instructions on how to install the OMERO plugin for 
ImageJ can be found at ​http://help.openmicroscopy.org/imagej.html​. 

3. Go to ​Plugins​ > ​OMERO​ > ​Connect To OMERO.​ This will show a login screen where you 
can enter the name of the server to connect to, the username and password. The OMERO 
plugin will allow you to browse your data in a similar manner to the webclient and open 
Images by double-clicking. 

4. Select the Images in the ​condensation​ Dataset. 
5. We will analyze cells by thresholding and segmenting the image. Go to ​Image > Adjust > 

Threshold. 
6. The ​Threshold​ dialog will pop up, click ​Apply.  
7. Another window ​Convert Stack to Binary ​will pop up. 
8. Select the following parameters: 

a. Method: Default 
b. Background: Light 
c. Calculate threshold for each Image 
d. Then click ​OK​.  
e. Close the ​Threshold​ dialog if you want. 

9.  
10. Select​ Analyze > Analyze Particles 
11. In the Analyze Particles dialog, select the following parameters 

a. with ​Size: 50-infinity 
b. Show: ​Outlines 
c. Check: ​Display results, ​and ​Add to Manager​.  

http://help.openmicroscopy.org/imagej.html


   
 

12. Click ​OK​.  
13. A dialog pops up asking to Process all 46 images? Click ​Yes. 
14. ROIs and Results table will be generated. 
15. Go to ​Plugins ​>​ OMERO ​>​ Save ROIs to OMERO​ to save these ROIs and the 

measurements as CSV file to the Image in OMERO. 

Analyze with ImageJ/Fiji: Scripting workflow (NOT PRESENTED, for information only) 

1. We will ​not​ demonstrate this workflow, this chapter is for information only. 
2. We will now repeat the manual analysis on a Dataset using the scripting facility available in Fiji. 
3. Log in to the webclient  
4. Select the Project ​idr0021​ and first Dataset ​CDK5RAP2-C​.  
5. Note its ID on the right-hand panel, it will be used below. 
6. Launch Fiji. (relaunch if opened). 
7. Go to ​File > New > Script…. 
8. A dialog pops up. In the ​Language​ menu select ​Python. 
9. Copy the content of the script 

https://github.com/ome/training-scripts/blob/v0.1.0/practical/jython/analyse_particles_for_another
_user.jy​ into the text editor. 

10. Edit the following parameters: dataset_id, USERNAME, PASSWORD. 

https://github.com/ome/training-scripts/blob/v0.1.0/practical/jython/analyse_particles_for_another_user.jy
https://github.com/ome/training-scripts/blob/v0.1.0/practical/jython/analyse_particles_for_another_user.jy


   
 

a.  
11. Click ​Run. 
12. The script will process all Images in the specified Dataset, applying threshold, analyzing particles 

and saving ROIs back to the Images in OMERO  
13. Go to the webclient, navigate to one of the images which were analyzed in the Dataset 

CDK5RAP2-C. 
14. Double-click to open the image in OMERO.iviewer. Demonstrate that the Image has now the 

polygon ROIs exported from Fiji and these are channel-specific. 

15. Select one ROI, from the ​ROIs ​menu in the top-left corner  select ​Export CSV 

.  
16. Download the output and open it in Excel to show data for ROI shapes. 

Create a Figure 

1. We now have both timelapse as well as non-time lapse images in the OMERO.figure. On 
all of the Images there are ROIs from the Fiji segmentation step above. The timelapse 
Images from the ​Dataset​ ​condensation ​were run through the Fiji script prior to this 
workshop. 

2. Select the two panels of the Images from the ​Dataset ​condensation ​by clicking or dragging 
a select region. Arrange the panels by dragging and resizing them. 

3. Duplicate both panels by selecting them, ​Edit​ > ​Copy​ and ​Edit​ >​Paste, ​or use the keyboard 
shortcuts. 

4. Use ​Align > Width & Height ​in the toolbar to ensure that the selected panels have all the 
same size.  



   
 

5.  
6. Arrange the four panels in a single column and snap the selected panels to a grid with the 

 button. 
7. In the ​Preview​ panel you can adjust the Time position and the rendering settings of the 

selected panels. 
8. Toggle channels on and off to show a ‘split-view’ of each image. 

9.  
10. Select all four panels, set the T-position to the start of Mitosis, e.g. position 8 (~35 minutes). 

Copy​ and ​Paste​ to create a new column. 
11. With these new panels still selected, increment T by clicking the ​>​ button one or more times. 
12. Copy​, ​Paste​ and increment T-index two or three more times to create a timelapse figure. 
13. Select the lower panels for the second Image and use the ​Down Arrow​ key to nudge them 

down to create a space between them and the upper panels. 
14. With ALL panels selected, use the Zoom slider to zoom in to approximately 200%. 
15. Then select all the upper panels and in the ​Preview​ panel pan the Image to show the cell of 

interest. Repeat for all the lower panels. 



   
 

16.  
17. Click on the ​Labels​ tab to add scalebar and labels to the selected Images. 
18. Select one of the ​Apoptosis​ Images that we previously edited in OMERO.iviewer and click 

the ​Edit​ button under the ROIs section.  
19. In the ​Edit ROIs​ dialog you can draw shapes on the Image using the toolbar buttons. 

Instead, we will click ​Load ROIs ​to retrieve ROIs from OMERO (if we have saved some on 
this image). 

20.  
21. A list of ROIs will be displayed. Add the polygon ROIs to the Image. 



   
 

22. Clicking on each row of the list will show the Image’s plane that the shape is saved on. 
Clicking the ​Add​ button will add the shape to the Image. Click ​OK​ to close. 

23. Use Shift-click to select just two panels (the last red panel for each Image). Under the 
Scalebar​ section, click on ​Show​ to display a scalebar created from the pixel-size metadata 
for each Image. 

24. Change the scalebar length to 2​0 ​μ​m ​and check the ​Label​ checkbox to show a label. 
25. In the ​Add Labels​ form, the drop-down list of the text input field can be used to create labels 

from existing image metadata such as timestamps, channel names or tags. 
26. Alternatively you can manually enter label text. 
27. Select 4 Images in the first column of the figure. From the ​Add Labels​ drop-down list, 

choose ​Channels​, select ​Left Vertical ​from the label position chooser and click ​Add​. 

28.  
29. Select all the Image panels showing the Green channel, using Shift-drag selection. Choose 

[time-mins] ​in the ​Add Labels​ input, ​Top right​ position and color: ​white.​ Click ​Add​. 
30. Finally, select the two Green Images in the first column and add labels from ​Tags​ metadata 

to the ​Top​ position of each panel. This will create labels for ​Mitosis​ and ​Apoptosis​. N.B.: if 
unwanted labels are created from tags, they can be removed or edited in the ​Edit Labels 
section 

31.  
32. Save the figure and check that the URL updates to a new URL for this figure which can be 

shared with colleagues. ​File > Open​ can be used to open your own figures or those of 
colleagues. 

33. Click ​Export PDF​ and when complete, click the ​Download​ button. Open the downloaded pdf 
in any suitable program and find the second page of the pdf. Click on the link to the image 
and see that you are navigated back to OMERO in your browser and the appropriate 
image, which was used in the Figure, is highlighted. 

Analyze metadata using OMERO.parade ​(PRESENTED depending on time) 

1. Select the ​Project​ ​idr0021​. 
2. Choose the ​parade​ option in the centre panel dropdown menu. 
3. Expand all Datasets by clicking on the ​Open All​ button. 

a. All the Datasets will be expanded in the left-hand tree. 



   
 

b. The Thumbnails will be loaded in the centre panel. This allows to browse a full 
project. 

Note that if you collapse a Dataset in the tree, the Thumbnails will be removed from the 
centre panel. 

4. In the ​Add filter... ​selection box, select the ​Key_Value ​item. 
a. When the Map Annotations are loaded, pick the Key ​Gene Symbol​ and enter the 

Value ​CEP ​to show all ​CEP​ genes and then ​CEP120​ to show only images with 
that gene. 

5. Repeat the previous step but this time: 
a. Pick the Key ​siRNAi. 
b. Enter the Value ​INCENP​ or ​Aurora-B​ or just ​B. 
c. To remove this last filter, hover over the filter and click the X button that shows on 

hover. 
6. In the ​Add filter... ​selection box, select the ​ROI_Count ​item.  

a. Enter a Value ​> 20. ​When you hover over the area used to enter the value, the 
range is indicated in the tooltip. 

b. Then enter < 3 or 4. 
7. Remove all filters by clicking the X button showing on hover. 
8. In the ​Add filter... ​selection box, select the ​Table ​item so we can find Images using the 

analytical results generated previously: 
a. Choose the ​max_points​ item and drag the slider to filter the Images. Note that 

PCNT​ has the largest number of Images with large ROIs. 

b.  
c. Adjust the controls to select ​< 50. 
d. Note that in that case ​CPAP​ and ​CENT2​ have the most of the  Images as 

expected. 

9. Switch to Table layout (middle button)  . 
10. In the selection box​ Add table data​…, select 

a.  ​Table_max_points 
b. Table_mean_points 
c. ROI_count 

Note that it is currently not possible to remove a column 
11. Click on the name of a column to sort it. 
12. Uncheck ​Show Datasets​ to sort all Images together e.g. by ROI count. 

13.  
14. Check the checkbox in each column to show the ​Heatmap​. Note the corresponding 

pattern in the Heatmap. 
15. Switch now to the Plot Layout (third button) 
16. It takes the table data loaded and plot the values. 



   
 

17. Filters can be added to plot the relevant results. 
18. Try plotting by different Axis values. 
19. Closing a Dataset in the left-hand tree removes the values from the plot. 
20. Drag to select several outliers. 
21. Note that you can use the selected Images in right-hand panel to annotate or ​Open 

with...​.  
22. Add a new Tag to the selected Images then find the Images with the tag.  
23. Preview Images and add Rating ​5​ to 1 or 2 Image(s) (1 per Dataset). 
24. We can now want to find Images in a Plate, open the Plate named 

INMAC384-DAPU-CM-eGFP_59223_1 
25. In the ​Add filter... ​selection box, select the ​Table ​item 
26. Then choose ​Ch0Max​ and drag the slider to filter Wells. Note that the plate layout does 

not change as Wells are found. 
27. Return to the ​idr0021​ Project. 
28. Filter by Rating - select all the Images then​ Open with Figure… 


